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Компьютер техникалари билан амалга ошириладиган  лаборатория 

машғулотларининг  мақсади – тажрибалар ўтказиш учун малака ва кўникма 

ҳосил ва замонавий техникани ҳар бир соҳага тадбиқ эта билишдир.Бу 

мақсадга эришиш учун ҳар бир ишни бажариш жараёнида сизга қатор 

масалаларни ечиш:; берилган ишдаги ходисаларнинг мохиятини 

тушинтиришга; татқиқ қилаётган объектнинг тавсифини бериш,уни 

характерлаш ва унинг ўзига хос хусусиятларини кўрсатиш; мазкур ишда 

қулланилаётган дастурий таъминотларни  танлаш, уларнинг ишлаш 

принципларини мукаммал ўрганиш. Бу лаборатория ишларининг тажриба 

натижаларини бажариш талабага, компьютер дастурлари билан ишлаш, 

лаборатория натижаларини таҳлил қилиш, асосланган хулосалар чиқариш ва 

иш бўйича хисобот тузишни ўрганиш имкониятини беради. 

Бундай мохирликка фақат узликсиз, мақсад сари интилувчан меҳнат 

қилиш натижасида ва ҳар бир тажрибага уйлаб, жиддий муносабатда булиш 

натижасида эришиш мумкин. Лаборатория машғулотларининг ўзига хос 

хусусияти шундаги, бошқа ўқув машқулотларидан фарқли у биринчи 

қадамданоқ сизни мустақиллигингизни талаб қилади, секин-аста сиз фақат 

лабораториядагина эмас, балки уйда амалда тўлиқ ва онгли фаол ишингизга 

айланиши керак  

Лаборатория ишларининг тафсифида қўйидагилар берилади:  

биринчидан, ўрганилаётган ишда учрайдиган ҳодисалар ҳақида қисқача 

маълумот , иккинчидан, ишда керак бўлган асбоблар ҳақида маълумот, 

учинчидан лаборатория ишини амалга ошириш усулининг тафсифи, 

тўртинчидан дастурий таъминотларнинг ишлаш имкониятларини ўрганиш, 

бешинчидан олинган натижаларга ишлов бериш усуллари ва барча 

лаборатория ишлар  учун  умумий бўлган  қўйидаги конкрет этаплар кетма-

кетлигини таркибида сақлайди, яъни: 

1. Бажариладиган ишнинг  мақсадини   аниқ ифодалаб беради; 

2. Ишда қўлланилаётган дастурий таъминотларнинг таҳлили; 

3. Лаборатория ишларини ўтгазишга олдиндан тайёргарлик, берилган ишда 

қўлланиладиган амалий дастурни аниқлаш,қўйилган масала кетма-

кетлигини аниқлаш ва уларни ифодалаб бериш, дастур форматларини 

аниқлаш; 
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4. Натижаларни аниқ ёзиш, шартларни қайд этиш, олиниши керак бўлган 

қийматларни ёки рўй бериши мумкин бўлган хатоликларни йўқотиш учун 

дастур имкониятларини чамалаб кўриш, олиналиган натижаларнинг 

ишончлилик даражасини аниқлаш; 

5. Натижаларга дастурий ишлов бериш ва хатоликларни етарли даражадаги 

аниқлик билан баҳолаш; 

6. Ишлаш кетма-кетликларини тизимлаштириш ва натижаларни 

умумлаштириш, жадваллар тузиш, графиклар чизиш, хулосаларни аниқ 

ифода қилиш, иш ҳақида хисоботлар ёзиш; 

      Мультимедиа тизимлари ва технологиялари фани “Ахборот сервиси” 

йўналишининг 2-курс талабаларига 4-семестр давомида ўтилади. Бу фанга 

маъруза 34 соат, лаборатория ишлари 16 соат ва амалий машғулотлар учун 16 

соат ажратилган.Фанни ўтилиши жараёнида талаба мультимедиа техника ва 

технологияларидан фойдаланиш, дастурларида ишлашни  ўрганади.Бу 

кўрсатмада “Мультимедиа тизимлари ва технологиялари” фанидан асосий 

лаборатория ишларини бажариш учун Microsoft Power Point ва Macromedia 

Flash MX   дастурларида амалга ошириладиган ишларнинг кетма-кетликлари 

аниқ мисоллар асосида тушунтирилган.  

          Талаба лаборатория ишларини бажариш жараёнида қўйидаги билим, 

малака ва кўникмаларга эга бўлади: 

1. Microsoft Power Point дастури ҳақида асосий тушунчалар 

2. Microsoft Power Point дастурида  ишлаш кўникмаси 

3. Microsoft Power Point дастурининг бошқа дастурлар билан ишлаши 

4. Microsoft Power Point дастурида презентацияларни яратиш 

5. Macromedia Flash MX   дастурининг ишлаш имкониятлари 

6. Macromedia Flash MX   дастурининг ойналари 

7. Macromedia Flash MX   дастурининг асосий панеллари  

8. Ulead Videostudio 10 дастурида овоз ва видеолар билан ишлаш 

9. Ulead Videostudio 10 дастурида видеоэффектлар ва матнлар билан ишлаш    
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1 - Лаборатория иши. 

 

Мавзу:Microsoft Power Point дастурида презентациялар яратиш. 

 

 

Ишдан мақсад: Microsoft Power Point дастури ёрдамида презентациялар 

учун слайдлар яратишни щрганиш. 

 

Ишнинг назарий қисми. 

Power Point – бу график дастурлар пакети бўлиб, электрон слайдларни 

тайёрлаш, улар билан танишишни уюштириш ва слайд фильмларни намойиш 

этишга тайёрлайди. 

Презентация- бу слайдлар ва маҳсус эффектлар тўплами бўлиб, уларни 

экранда кўрсатиш, тарқатиладиган материал, докладни план ва конспекти 

шаклида бита файлда сақланади. 

Слайд-бу презентациянинг алоҳида кадри бўлиб, ўз ичига матнни , 

сарлавҳаларни , график ва диаграммаларни олиш мумкин. 

Дизайн қолипи- профессионал томонидан олдиндан тайёрлаб қўйилган 

графиклар,бўёклар, жилолар, товушлар намунаси бўлиб, улар слайдларда 

ишлатиш учун мўлжалланган. 

Анимация- бу слайдларни намойиш қилиш ва кўрсатишда уларни 

самарадорлигини  ошируви  товуш , ранг, матн ва ҳаракатланувчи эффектлар ва 

уларни йиғиндисидан иборат. 

Power Point бир нечта слайдларга эга бўлган презентация файлини очади. 

Бу дастур фойдаланувчига ҳар хил мавзуларда катта миқдорда презентация 
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қолипларини тақдим этади.Бу қолиплар маҳсус усулда жиҳозланган слайдларга 

эга. Слайд майдончасига матнни, графикани, жадвал ва диаграммаларни 

жойлаштириш мумкин. Ундан ташқари биз дидимизга мос дизайн танлаб 

санъаткорона жиҳозлашган презентация қолипини ўзгартиришимиз мумкин. 

Бунда презентация мазмуни саклаб қолинади,фақат унинг ташқи кўриниши 

ўзгаради. Power Point программасини қуйидаги кетма – кетликда ишга 

туширилади. 

Пуск- Программы- Power Point 

                       Power Point программасининг асосий элементлари. 

Экранда ахборотларни ифодалаш. Power Point фойдаланувчига ишлаш ва 

ахборотларни ҳар хил кўринишларини томоша қилиш имкониятини беради. 

Дастур бош ойнасининг қуйи қисмидаги тугмачалардан бирини босиб 5 та 

кўринишлар билан танишиш мумкин. 

1. Слайдлар қиёфаси анча қулай ҳолда бўлади, агар биз оҳиста ҳар бир 

слайдни шакллантирсак ,унга жиҳоз танласак, унга матн ёки графика 

жойлаштирсак. 

2. Презентация матни билан ишлаш учун тузилма қиёфасини ўрнатиш керак. 

Бу ҳолда слайдлар сарлавҳаси,презентациянинг матн ва тузилмаси  билан 

танишиб чиқиш мумкин бўлади. 

3. Слайдларни сараловчи қиёфаси слайдларни экрандаги муддатли бошлаш 

учун жуда қулайдир. Бундан ташқари бу режимда слайдларни 

алмаштириш мумкин. 

4. Қайд (белгилар) қиёфаси докладларга белгилар қўйиш учун ишлатилади. 

5. Намойиш бажарилган натижасини қуришда ишлатилади. Бу режимда 

слайдлар навбати билан экранга чиқарилади. Керакли киёфани қуриш учун 

«Вид»менюсидаги командани фойдаланиш мумкин. 

Намуналар билан ишлаш. Презентация киёфасини яхшилаш учун  унинг 

барча слайдларини бир маромда жиҳозлаш керак. Бундан ташқари ҳамма 

слайдларга  биттагина дизайн элементини жойлаштириш учун зарурият 

яратилади. Шунинг учун Power Point да барча слайдлар учун бир хилда 

жиҳозлаш имконияти мавжуд. Бу намуналар билан ишлаш режимда амалга 

оширилади. Бу режимга кириш учун  Вид менюсидан «Образец» буйруғини 



 9 

чақириш даркор . менюлар слайдлар учун «Образец слайдов» ва «Образец 

заголовков» буйруқлари кўрсатилган. Иккинчи буйруқ титул 

слайдларнингнамунасини аниқлашда, биринчи эса презентациянинг барча 

қолган  слайдлар қиёфасини аниқлашда ишлатилади. «Образец слайдов» 

командасида хар бир намуна учун қандай ўзгаришлар киритиш учун  нима 

килиш кераклиги тўғрисида йўл-йўриқлар келтирилган. 

Санъаткорона жиҳозлаш. Презентация тайёрлашнинг асосий босқичи – 

бу  санъаткорона  жиҳозлашдир: чунки график қиёфаси  маълумотлар  

матнлиларга нисбатан кўркамроқ бўлади, иккинчидан график қиёфа 

презентациянинг асосий белгиларини ажратиб кўрсатиши ёки 

маърузаларнинг мураккаб ҳолатларини тушунишни осонлаштиради. 

Дизайн қолипи. Power Point фойдаланувчиларга мутахассислар 

томонидан тайёрланган кўп микдордаги дизайн қолипларини бериб, 

формат менюсидаги Применить шаблон дизайн командаси ёрдамида 

бажарилади. Команда чақирилгач, бир номли  дарча очилади, дизайн 

қолипида чиқиллатишни бажарсак, олдиндан кўриш дарчасида  унинг  

тасвирини кўрамиз. У ёки бу қолипни танлаш учун унда қўшимча 

чиқиллатишни бажариш керак. 

График объектлар расмни чизиш. Power Pointда хар қандай мураккаб  

график объектлар расмини чизиш мумкин. Бунинг учун Рисование номли 

асбоблар панели мавжуд. Агар биз берилиши кўринишида тузсак, у экранда 

пайдо бўлади. Расм чизишнинг  қўшимча воситалари Рисование асбоблар 

панелида  жойлашган. 

Агар сичқонча кўрсаткичини истаган панелида тўғрилаб, ўнг томонидаги 

тугмачани боссак, у экранда акс этади. 

Power Point даги асосий расм чизиш усуллари қуйидагича: 

Қандайдир шаклни чизиш учун асбоблар панелидан керакли тугмани  

босиб расм чизиш асбоблари танлаб олинади; 

Ҳар хил бир неча объектларни чизиш учун ёки тайёр бир хил амалларни 

бажариш учун тугмачада кўшимча чиқиллаш бажарилади; 

Ҳосил қилинган шакл устида қандайдир амал бажариш учун уни 

қорайтириш керак; 
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Бошқа объектлар билан бутунлай ёки кисман тўсилган объектни тақаш 

учун биринчи пландаги объект қорайтирилади,сўнгра тугмача босиб 

турилади, керакли объектга қаратгунча; 

Эллипс асбоби билан айлана, Прямоугольник билан квадрат, айлана 

дугасини чизиш учун расм чизиш жараёнида (Shift) тугмасини босиб туриш 

керак; 

Линия асбоби билан чизилган чизиқ горизонтал ёки вертикал бўлиши 

учун (Shift) тугмачасини босилган ҳолда ушлаб турилади; 

Сигриегта объектларни қорайтириш учун (Shift) ни ушлаб туриб 

сичқонча билан кетма кет чиқиллатилади.Барча чизмаларни қорайтириш 

учун (Ctrl+A) тугмачалари босилади. 

Clip Art кутубхонасидаги расмлар. Презентацияни жиҳозлаш учун 

расмларга эга бўлган Microsoft Clip Art кутубхонасидан олиш мумкин. 

Асбоблар панелидаги Вставить  графиги тугмачасини босиш билан Clip 

Art кутубхонасига кириш мумкин. 

Агар биз Разделы рўйҳатида Все разделы элементини танласак, у биз        

алфавит тартибига жойлашган кутубхонадаги ҳарфни кўришимиз мумкин. 

Маълум мавзудаги расмларни кўриш учун разделы рўйхатида уни танлаб 

олиш керак. Расмни слайдга киритиш учун  унда қўшалоқ чиқиллашни 

бажариши керак. Унда расм ҳосил бўлгач, биз унинг экрандаги ҳажми ва 

жойини кўришимиз мумкин. 

Power Point аудио ва видеоклипларни презентациялар таркибига кириш 

имконини беради. Бундай  имкониятлар билан танишиш махсус  аппаратура-

видео ва аудио карталар, яхши дисплей ва жуда сифатли акустик система 

,аудио ва видеофайллар керак бўлади. 

Power Point муҳитида презентациялар яратиш технологиялари 

“Мастери содержания» ёрдамида презентация яратиш. Power Point 

программасида чиқиллаш бўлгандан сўнг Microsoft Office панелида уларнинг 

бош ойнаси ва презентациялар билан ишлашда кўмак берадиган  

ахборотларни ўз ичига олган «Полезный совет» номли диалог дарчаси ҳосил 

бўлади. Бу дарчадаги “Следуюший” тугмачасини босиб, навбатдаги 

маслаҳатни ўқиш мумкин. “ОК”тугмачасини босиб  дарчани ёпилади.Power 
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Point нинг диалог дарчаси ёпилгач, презентация ҳосил қилишнинг бир неча 

усулларини таклиф қилади:автоыиймат Мастерни қўллаб, презентация 

номини ёки презентацияни яратиш. Ундан ташқари биз амалдаги 

презентация файлини очиш имконитига эга бўламиз. 

Агар биз ҳар хил маърузалар ва реклама компанияларида тайёрлаш 

ишида тажрибасизлик қилсак , у автоқиймат Мастеры ёрдамидан 

фойдаланган маъқул, яъни мос селектор тугмачасини танлаб, ОК тугмачаси 

босилади. Натижада экранда кетма-кет ойна диалог дарчалари пайдо бўлади. 

Уларда биз презентациямиз асосий тавсифномалари учун  фойдаланишимиз 

мумкин. Автоқиймат Мастердаги навбатдаги диалог дарчасига ўтиш учун 

Далее тугмаси босилади, олдинги дарчага ўтиш учун эса «Назад» тугмачаси 

босилади. 

Титул слайдини жиҳозлаш учун эса маълумотларни киритилган дарчага 

биз ўзимиз тўғрисидаги маълумотларни, фирма номини иккисини 

киритишимиз мумкин. Бу ахборотлар титул слайдида жойлашган бўлади. 

Автоқиймат Мастерининг 3- дарчаси асосий ҳисобланади ва 

презентациянинг қуйидаги хиллари мавжуд: 

 стратегия тасвирномалари: 

 махсулотлар сотуви, хизмати ёки ғоялари: 

 ўқитиш: 

 ютуқлар тўғрисида ҳисобот: 

 нохуш янгиликлар тўғрисида хабарлар ва б.қ. 

Масалан, биз махсулотлар сотуви, хизмати ёки ғоялар хилини танладик. 

Бунда махсулотимизнинг афзаллиги, хизмат кўрсатиши янги ғоялар ва шу 

кабилар тўғрисида гапириб бериш мумкин. 

Агар бу даражагача бизга маъқул бўладиган бўлмаса у холда «Другой” 

тугмачани босиб, презентация қолипи рўйхатга олинади. “Даже” тугмачаси 

босилса, автоқиймат Мастерни охирги дарчасига тушилади. Акс ҳолда биз 4 – 

дарчада презентация жихозининг маъқул усулини танлаймиз ва гапимизни 

давоб эттиришимиз мумкин. 5 – дарчада биз презентация олиш усулини 

танлаймиз ва тарқатув материалларининг бизга керак ёки нокераклигини 
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кўрсатамиз. Шундан сўнг, 6 – дарча бизга презентация яратиш бўйича 

қилинган ишлар якунланганлиги тўғрисида хабар беради ва «Готово” тугмаси 

босилишини кўрсатади. Бироздан кейин компьютер экранида презентация 

титут слайди кўринади. Қилинган ишнинг натижасини йўқотмаслик учун файл 

менюдан “Сохранить” командасини чақириб презентация мос папкага 

жойлаштирилади.  

“С нуля” командаси ёрдамида презентация яратиш. Агар биз Рол Рении 

ни чақирганимизда очилган диолог дарчасини ёки биз ишлаётган 

презентация файлини ёпсак, у холда янги презентация хосил қилинган Файл 

менюсидан Создать командасини чақиришга тўғри келади. Шундан кейин 

экранда Дизайны презентации фаол қисми билан создать презентацию 

дарчаси пайдо бўлади. Бу диалог дарчада презентация қолип дизайн бериш 

мумкин.  Просмотр дарчасидаги слайдлардан бирини чиқиллатиб, уни 

тасвирини кўриш мумкин. Слайд қолип устида қўшалоқ чиқиллатсак, Создать 

слайд диалог дарчаси очилади. Выберите  авторазметки да янги яратилган 

слайд учун авторазметка аниқлаш мумкин. Дарчанинг пастки ўнг томонида 

унинг намуна тасвирномаси берилган. Авторазметка намунаси устида 

қўшалоқ чиқиллатилса, экранда кнопкали янги слайд пайдо бўлади.  

Вставка менюсида  Создать слайд танлаб олиб, чақирсак янги слайд 

яратилган дарчага эга бўламиз. Вид Создать презентацию дарчасига келамиз. 

Агар Презентация кўпроқ фаоллаштирилса, у холда автоқиймат мастерини 

ишга туширишва презентация қолипини танлаш мумкин. Энди умуий бўлимни 

жойлаштирамиз. Биз MSOffice/Шаблоны папкасидаги Power Point слайдлар 

рўйхатини кўрамиз. Ҳозир бу ерда фақат Новая презентация қолипи 

жойлашган. Бу қолипда чиқиллаш бажарилса, экранда Создать слайд дарчаси 

пайдо бўлади. Қўшалоқ чиқиллатиш билан слайднинг бизга керакли 

қиёфасини танлангач, экранда слайд пайдо бўлади, лекин у санъаткорона 

жихозга эга бўлмайди ва биз мустақил унинг жихозини тайёрлашимиз мумкин 

бўлади.  

Power Point да презентация яратиш ва жихозлаш.  Презентацияни 

яратиш жараёни 3 – босқичга бўлинади:  

 презентацияни тўғридан-тўғри тайёрлаш,  яъни хар бир слайдни 

жихозлаш.  
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 оқ – қора вариантдаги слайдларни кўрсатувчи тарқатувчи 

материалларини тайёрлаш; 

 намойиш, яъни тайёр слайдларни кўрсатув жараёни;  

Куйида кафедрани реклама килувчи кичик презентацияни тайёрлаш 

боскичлари келтирилган . 

Файл менюсида  создать ctrl+N оркали презентация яратилади.Бунда 

«создать презентация» мулокат ойнаси пайдо булади. «Дизайны презентация» 

вкладкаси оркали ихтиёрий презентация тури танланади Пульс дизайн турини 

танлаймиз ва OK  ёки Enter  босилади.Кейин Создать слайд мулокат ойнаси 

пайдо булади ,бунда слайд кандай турда яратилиши танланади ва ОК 

босилади. 

Сичкончани бир марта туртиш  оркали Информатика кафедраси деган 

текст киритила. 

Выставка менюси даги рисунок кисм менюси дан картинки ёки стандарт 

инструментлар панелидаги  Дабавит картинку  тугмачаси оркали “Microsoft Clip 

Gallery 3.0” дан керакли расм танланади ва Вставить оркали слайдга куйилади. 

Обьект улчамларини визуалц  узгартириш мумкин. 

Вставка менюсидаги Создать слайд ёки Стандарт инстуметлар панелидаги 

создать  слайд оркали иккинчи слайд яратилади. 

Керакли обьектлар,расмлар ,матнлар киритилади ва бир нечта слайд 

яратилади. 

Показ слайдов менюсида слайдлар алмашиниш  эффекти танланади.Бунда 

секин  открывание вправо – вверх, туртиш оркали ёки автоматик 2 секунддан 

кейин слайд алмашинишини танлаймиз ва применить по всем оркали барча 

слайдларга татбик этамиз. 

Показ слайдов менюсидаги Настройка анимация оркали  слайдлардаги  

обьектлар ,сузларни экранда пайдо булиш турлари  танлаймиз .Мисол учун, 

Информатика  кафедраси сузини эффект вкладкаси оркасида вращение 

эффектини ,  Появление текста  по словам турини танлаймиз. Анимациясига  

Время вкладкаси оркали включить ёки выключить объект ё текстларни 

анимацияга киритилади ёки олиб ташланади.    
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Показ слайдов менюсидаги Показ  кисм менюси оркали  презентация  

демонстрация килинади.  

Ишнинг бажарилиш тартиби: 

Бўлажак презентация мавзусини ёзинг, слайдлар миқдорини ва 

разметкасини аниқланг. Слайдларни жихозлаш вариантларини ишлаб чиқинг. 

Power Point ни ишга туширинг. Power Point дарчаси пайдо                  бўлсин. 

Создать новую презентацию танлов майдонида Пустую презентацию ни 

танланг. Слайдларни белгилашнинг ҳар хил вариантли кўрсатадиган показь 

слайд дарчаси пайдо бўлади.  

1. Формат менюсида Применить шаблон дизайна командасини топинг. 

Дизайн қолиплари бир хилда презентация яратиш имконини беради.  

2. Клавиатурадан сарлавҳа ва сарлавҳача матнини киритинг. Бунинг учун 

сичқонча билан чиқиллатинг ва матнни киритинг. Матн танлаб олинган 

дизайн қолипига мос равишда жихозга эга бўлади.  

3. 1 – слайд тайёр. Янги слайдни киритиш учун (Вставка-Создать слайд) 

командасини бажаринг. Создать слайд белгиловчисини танланг.  

4. Сарлавҳа метка-заполнителя да сичқонча билан чиқиллатиб янги сарлавҳа 

киритиш имконини беради.  

5. Чап устуннинг метка-заполнитель да чиқиллаш матн киритиш имконини 

беради. Устун ичида янги абзац (сўз боши) га ўтиш (Enter) командаси 

орқали бажарилади.  
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6. Биринчи устун матн билан тўлгач, иккинчи устун меню-заполнител да 

чиқиллатинг.  

7. Олдинги слайд сингари янги слайдни хам тайёрланг. Бу ишни қуйидаги 

схема бўйича мустақил бажаринг:  

 янги слайд қуйинг;  

 мос белгиловчи танланг; 

 матн киритинг; 

 зарурият юзасидан матнни бир неча устунларга жойланг; 

 зарур бўлиб қолса, метка-заполнителни силжитинг; 

 матнни хохишга қараб тартибга солинг.  

8. Файл-печать командасини бажаринг. Печатать рўйхатни варақдаги 

керакли слайдлар миқдорини танланг, черно-белый переключателини 

фаоллаштиринг . 

9. Намойиш қилиш учун Вид – Демонстрация командасини бажаринг. 

Биринчи слайд экранда тўла холда пайдо бўлади. Намойиш режимида 

навбатдаги слайдга ўтиш чиқиллатиш (сичқонча билан) орқали 

бажарилади. 

Ҳар бир талаба берилган мавзулар бўйича лаборатория ишини бажаради.  

 

Топшириқни бажариш учун мавзулар: 

1. ТАТУ Қарши филиали 

2. Савдо магазини 

3. Компютер магазини 

4. Китоб дўкони 

5. Банк 

 

Назорат саволлари. 
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1. Power Point дастурида нечта кўриниш билан ишлаш мумкин? 

2. “Мастери содержания» ёрдамида презентация яратиш 

3. “С нуля” командаси ёрдамида презентация яратиш 

4. Power Point да презентация яратиш ва жихозлаш. 

 

2-Лаборатория иши. 

 

Мавзу: Power Point программасининг бошқа амалий программалар 

билан ўзаро алоқаси.  

 

Ишдан мақсад: Microsoft Power Point дастурини Microsoft Word   ва 

Microsoft Excel дастурлари билан боғлашни ўрганиш. 

 

Ишнинг назарий қисми. 

 Бизнинг презентациямизда электр жадвалини қўллаш учун Excel, Word 

дастурларининг ёрдами керак бўлади, чунки жадвални бошқа жойда тузиб 

презентациямизга жойлаштириш мумкин бўлади.  

 Word – жадвалини Power Point да ишлатиш.  

 Биз Power Point да жадвал тузишимиз мумкин.  

Лекин агар жадвал Word да тузилган бўлса, уни презентацияда қўллаш 

мумкин, хатто керак ҳам. OLE деб аталган шеки томонлама характли 

магистрали имкониятидан фойдаланиб, Word жадвални слайд билан боғлаш 

мумкин.  

 OLE қисқартирилган сўз бўлиб объектларни боғлаш ва тадбиқ этиш (object 

linking and embedding) мазмунини англатади. Дастурда Windows мадаги файлни 

иккинчи бир дастурга ихчам киритиш ва жойлаштириш имконини беради. Агар 

биз шу каби ахборотларни тадбиқ этсак, у холда бу ахборот сақланаётган 

жойидаги барча хужжатлар билан бирга узатилади. Агар у боғланса, биз уни 
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хоҳлаган жойида сақлашимиз ва у билан ота-она дастурида ишлашимиз 

мумкин. Хар гал бу боғланган хужжатни очишда, бу хужжат автоматик равишда 

янгиланади.  

 Power Point жадвалини тузиш қийин эмас: фақат Создать слайд и выбрать 

слайд с таблицей тугмачасига мурожаат қилиш кифоя. Word жавдвалини 

слайдга қўшиш бироз мураккаб. Жадвални слайдга жойлаштиришдан олдин 

Windows дастуридаги Буфер обменада нусхасини олиш даркор.  

  Ишни бажариш тартиби.  

1. Курсорни хоҳлаган жойга қўйиб, Word да жадвални қорайтирамиз ва 

Таблица, Выделить таблицу ларни танлаймиз.  

2. (Ctrl+c) ни босамиз ёки Правка, Копировать ларни танлаймиз. Натижада 

қорайтирилган жадвал Буфер обменада нусҳаланади.  

3. Power Point дастури ишга туширилади. Бунинг учун Office асбоблари 

панелидаги Power Point тугмаси босилади.  

4. Слайдларни кўриш режимда ўтилади ва жадвални ўрнатмоқчи бўлган 

ёки Создать слайд тугмасидан фойдаланиб, янги слайд яратилмоқчи 

бўлган слайд топилади.  

5. Правка, Специальная вставка танланади.  

6. Объект документ Microsoft Office да чиқиллатилади. Кейин связать 

селектр тугмаси босилади. Вставить ни  танлагач, биз жадвални тадбиқ 

этамиз ва бошланғич хужжатлар билан барча алоқаларни узамиз.  

7. Ок тугмасини чиқиллатамиз.  

        Боғланиш яхши қўлланиладиган холлар шуки, агар жойлаштрилган 

маълумотларни кўп марта тахрирлаш тўғри келса,  лекин Word жадвалини 

презентацияга нусхалаш учун қуйидагиларни бажариш керак:  

1. Word да жадвал қорайтирилади.  

2. (Ctrl+c) босилади ёки Правка, Копировать танланади.  

3. Power Point га ўтилади.  

4. Бизга керакли слайдга ўтилади.  
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5. Слайдни кўриш режимига ўтилади.  

6. (Ctrl+v) ёки Правка, Вставить танланади. (Буфердаги жадвални чиқариш 

учун) 

     Excel электрон жадвалини слайд блан улаш.  

    Дастурлар аро маълумотларни узатиш учун биз кўп марта Буфер обмена 

ёрдамига мухтож бўламиз. Excel электрон жадвалини очиб қуйидаги 

қадамларни бажариш керак.  

1. Нусхаланувчи ячейкалар қорайтирилади. Буфер обменага нусха кўчириш 

учун (Ctrl+c) босилади.  

2. Power Point га кўчирилади, Слайдларни саралаш режимида.  

3. Электрон жадвал жойлашадиган ёки янги слайд яратилган слайдга 

ўтилади.  

4. Правка, специальная вставка танланади.  

5. Microsoft Excel даги объет листга чиқарилади ва связать селектр тугма 

босилади.  

6. Ок тугмасида чиқиллаш бажарилади.   

 

   Назорат саволлари. 

1. Microsoft Power Point дастурининг имкониятларини айтинг. 

2. Microsoft Power Point дастури экранини тушунтиринг 

3. Microsoft Power Point дастурининг бошқа амалий дастурлар билан ўзаро 

алоқаси қандай ташкил этилади? 

3 - Лаборатория иши 

 

Мавзу: Macromedia Flash MX дастурида матнлар билан ишлаш. 
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Ишнинг мақсади: Macromedia Flash MX дастурида матнлар билан 

ишлашни ўрганиш. 

        

Назарий қисм: Macromedia Flash дастури анимация яратишда дунёда кенг 

қўлланиладиган дастур. Бу дастурда ишлашни оммавийлашганлиги 

сабабларидан бири, ишлашда дастур интерфейси қулайлиги, ҳамда 

функциялари кўплигидадир.  

Macromediа Flash MX дастури билан ишлаш учун зарурий воситалар. 

1. Intel Pentium 200MGS (Яхшиси  400) процессори. 

2. 64 Мб дан кам бўлмаган оператив хотира (яхшиси 128 мь дан бошлаб). 

3. Қаттиқ дискда 85 Мб бўш жой. 

4. 1024х768 пиксел ва 16 бит рангли монитор 

5.  Windows 98 SE, Windows ME,  Windows NT 4.0 Windows 2000 ёки    

     Windows XP операцион тизими. 

Flash интерфейси Adobe фирмасининг дастурлари (масалан, PhotoShop) 

интерфейсига ўхшаш бўлиб, нуқтали графика билан ишлашга мўлжалланган. 

Чапда чизиш учун мўлжалланган инструментлар панели жойлашган. Улар 

ёрдамида инструментлар танланиши, шунингдек ишчи соҳани бошқариш, 

объектларни ўзгартириш ва ранглар танлаш мумкин. Ўнг томонда 

инструментларда созлаш, ранг, матн, кадрлар хусусияти ва объектлар 

палитралари жойлашган. Ўртада ишчи соҳа, унинг устки қисмида эса вақт 

диаграммаси {Timeline) жойлашган. Ишчи соҳада алоҳида график ва матнли 

элементлар яратилади. 

Ишчи соҳа остида хусусиятлар палитраси {Properties) жойлашган бўлиб, у 

турли объектлар хусусиятларини ўзгартириш учун мўлжалланган. 

Flashда бажарилган ишларнинг натижасини (файллар, анимация, са-

ҳифалар) — мултифилм, клип, видеофрагмент, роликва анимациялар деб 

аташ қабул қилинган (умумий термин — movie). 

Flashда ролик яратиш жараёни қуйидагича: 
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Дастлаб FLA кенгайтмали бошланғич ёки муаллифлик файл (таҳрирлаб 

бўладиган бошланғич файл) яратилади. Кейин браузерда кўриш мумкин 

бўлган SWF-файлга ўзгартирилади. Бундан ташқари, ишнинг натижаларини 

кенг тарқалган форматлар файллари AVI, анимацион GIF, JPEG ва бошқа 

форматларга экспорт қилиш мумкин. 

Macromedia Flash дастурида ишлашимиз учун бу дастуримизни ўзимизга 

ўрнатиб оламиз. Ўрнатиб олганимизданг сўнг Пуск→Все программы 

→Macromedia→Macromedia Flash MX 2004 жараёнини бажарамиз. 

 

 

 

Macromedia Flash дастурига киришимиз билан қуйдаги ойна ҳосил бўлади. 
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Бу ойна янги фойдаланувчиларга ўзига ҳос йўл деб билсак ҳам 

бўлади,масалан унда шаблонлар, уқув қулланмалар мавжуд бўлади. 

Бу ойнадан янги иш бошлашимиз учун   Flash Document  қисмини 

белгилаймиз. 
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        Кўриб турганимиздай Flash дастурининг интерфейси кўпгина блоклардан 

ташкил топган. 

         Flash дастурида Шрифтларни ўзгартириш мумкин, бунинг учун… 

Tools палитрасидан     белгисини белгилаймиз ва иш столимизга масалан 

TEXT деган матни киритамиз. 

 

 

 

 

 

 

 

 

  

 

 

 

 

 



 23 

 

 

 

 

     Ёзган матнимизни буяш учун Tools блокида берилган   инструмент 

ёрдамида ёзган матнимизни белгилаймиз ва пастки Properties блокидан 

ранглар палитрасини танлаб ўзимизга керакли рангни қуйишимиз мумкин…   

 

 

 

       Иш столомизга аниқлик киритиш керак бўлса қуйдаги функцияни 

бажаришимиз мумкин. 

View-Grid-Show Grid ва иш столимизда қуйдаки ўзгариш ҳосил бўлади. 
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 Назорат саволлари. 

1. Properties блоки вазифаси нимадан иборат?  

2.    Элементини тушунтиринг?      

3. Tools палитрасидан   

4. Tools палитрасидан  нима учун фойдаланилади? 

 

 

 

 

4-Лаборатория иши. 

 

Мавзу: Дастурга ташқи объектларни киритиш 

 

Ишнинг мақсади: Macromedia Flash MX дастурида ташқи объектлар 

билан ишлашни ўрганиш. 
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Назарий қисм:Ишнинг бошида айтилганидек Macromedia дастурида 

асосан Flash дастурида анимация яратиш билан боғлиқ иш қилинади. Иккинчи 

ишимиз оз бўлсада аниманцияга қаратилган бўлиб унда Timeline блокидан 

қандай фойдаланишни кўрсатиб беради… 

Windows-Library(Ctrl+L) функсиясини бажарамиз ва Flash интерфейсининг ўнг 

томонидан Library  блоки ҳосил бўлади, унда биз фойдаланмоқчи бўлган хар 

хил объектлар мавжуд. Расмни экранга олиб ўтамиз… 

 

 

 

Timeline блокида слойлар ҳамда, фрамларди киритишимиз мумкин 

бўлган интерфейс мавжуд.. Tiny ни белгилаймиз 30 ни белгилаб ўнг томондан 

менюдан Insert key frami ни белгилаймиз… 
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       Янги слой қушамиз ва анимация ҳосил қиламиз… Янги слойди ҳосил 

қилишимиз учун Timileni блокидан янги Слой қушишимиз мумкин… 

 

 

 

        Ва яна tenydi белгилаб 30 дан 60 гача бўлган frame ларни белгилаймиз.  

Қилган ишимизни кўриш учун Control – Test Movie(Ctrl+Enter) функциясидан 

фойдаланишимиз мумкин… 
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        Қилган ишимизни қуйдагиша эксперт қилишимиз мумкин…  

                  File-Export-Export Movie.  

 

 

 

        Файл формати стандарт (*.swf), буни ўзгартиришимиз мумкин. Мос 

проигривателга форматда сақланади. Windows AVI (*.avi)  да сақлашимиз 

мумкин.  

 

 

Ва яна қуйидаги ойна ҳосил бўлади… 
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         Бу ерда Compress video қилган ишимизни сиқишга имкон беради. 

Smooth агар растрли бўлса эксперт қилишда фойдаланилади 

Sound формат керакли бандини танланади. Моно ёки Стеро.   

Назорат учун саволлар 

1. Aнимациянинг асосий тушунчалари нималардан иборат? 

2. Кетма-кет кадрли ва интерполацион анимация нима? 

3. Macromedia Flash MX дастури хусусиятлари. 

4. Flash дастуридаги вақт шкаласи имкониятлари. 

 

5 - Лаборатория иши 

    

Мавзу: Macromediа Flash MX дастурида Shape  Tweening  ва  Motion 

Tweening  усулиларида анимацион символлар яратиш. 
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   Ишнинг мақсади: Macromediа Flash MX дастуридаги Shape  Tweening ва 

Motion Tweening   усулидан  фойдаланиш ва улар ёрдамида кичик анимация 

кўринишини яратишни ўрганиш. 

Ушбу усул  асосан объект формасининг бир турдан иккинчи турга 

ўзгаришига асосланган.             

Биринчи марта Oval (O) инструменти ёрдамида айлана чизиб оламиз. 

Эллипс эмас, балки айлана ҳосил бўлиши учун SHIFT тугмаси биргаликда босиб 

турилади. 

Arrow (A) элементини ишлатинг ва Timeline бўлимида 30кадрни белгиланг. 

Бош менюдан Insert>Keyframe (F6) буйруғини бажаринг. Бу ҳаракат билан сиз 

30 кадрни калит кадрга айлантирдингиз. Эътибор беринг, линейка остида 

кадрлар кулранг рангга бўялиб қолди. 

 

30 кадрда Rectangle (R) инструменти ёрдамида айлананинг чап қисмида 

тўртбурчак чизинг. Arrow (A) инструментини танланг ва айланани белгилаган 

ҳолда DELETE тугмаси ёрдамида уни ўчириб ташланг. 

 

Сичқонча тугмасини 1-30 кадрлар орасида икки марта босинг ва ҳосил 

бўлган  панелдан Tweening бўлимини танланг.Shape  ҳолатини ўрнатинг 

1-кадрда курсорни ўрнатган ҳолда, ENTER тугмасини босинг ва ҳосил бўлган 

анимацияни кўринг. Охирги натижани кўриш учун эса CONTROL>Test Movie 

(CTRL+ENTER) буйруғини бажаринг 

Мазкур усул объект хусусиятларини бошқариш учун хизмат қилади. Энг оддий 

фойдаланиш сифатида объект координаталарининг ўзгаришини келтиришимиз 

мумкин. 
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1.1-Қадамдаги сингари янги файл яратинг ва айлана чизинг. Paint Bucket (U)  

инструменти ёрдамида оқ-қора радиал градиент билан унинг ичини бўянг 

  Объектни белгиланг (Insert>Select All(CTRL+A))ва бош менюдан Insert>Convert 

to Symbol.....(F8) буйруғини бажаринг.  Name  майдонида объектга ном беринг: ball 

Белгилашни бекор қилмай туриб, Window>Inspectors>Object панелида 

қўйидаги параметрларни ўрнатинг:  x= 150, y= 50, w=50, h= 50. 

61-кадрни калит кадр қилинг (1.2-қадам). 

Сичқонча тугмасини 1-30 кадрлар орасида икки марта босинг ва ҳосил 

бўлган  панелдан Tweening бўлимини танланг. Motion  ҳолатини ўрнатинг. 

31-кадрни калит кадр қилинг (F6). 

Ушбу кадрда объектни танланг ва Object панелида у =250 координатасини 

ўрнатинг. Биринчи кадрда курсорни ўрнатган ҳолда, ENTER ни босинг ва 

натижани кўринг. 

Тасаввурнинг тўлиқ ҳосил бўлиши учун 28 ва 34-кадрларни калит кадр 

қилинг, шундан сўнг 31-кадрда Window > Inspectors > Transform панели 

ёрдамида коптокни вертикал бўйича қисқартиринг (ҳ = 80% ). 

 

Назорат саволлари. 

1. Motion  ҳолатини қандай қилиб ўрнатиш мумкин. 

2. Paint Bucket (U)  элементи вазифаси нимадан иборат 

3. Motion Tweening  усулини  тушунтириб беринг. 

 

                          

6 - Лаборатория иши. 

    

 Мавзу:  Ulead Videostudio 10 дастурида матнлар билан ишлаш 
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Ишнинг мақсади: Ulead Videostudio 10 дастурида матнлар билан ишлашни 

ўрганиш 

 

Назарий қисм: Ulead Videostudio 10 дастурида матн овоз ва видео билан 

биргаликда ишлаш ёки турли видеоэффектлар яратиш мумкин мумкин. Ulead 

Videostudio 10 дастур қуйидаги кетма-кетликни бажариш орқали ишга 

туширилади: ПУСК→Все програрммы→ Ulead Videostudio 10. Экранда қуйидаги 

ойна ҳосил бўлади:  

  

Биринчи қатордаги VideoStudio Editor бўлимини танлаймиз. Қуйидаги ишчи 

ойна ҳосил бўлади: 
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Юқоридаги панелдан Title бўлимини танлаймиз ва ўнг юқори тарафда ҳосил 

бўлган матн ёзиш учун мўлжалланган махсус андозалардан бирини танлаймиз. 

Сўнг асосий дарчага керакли матнни киритиш мумкин. 
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Ёзилган матнни сичқонча ёрдамида пастки қисмга тушириш мумкин.  
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Бундай матнлар асосан фильм ёки роликларнинг номини беришда 

ишлатилади. Ulead Videostudio 10 дастурида ишланган ихтиёрий файлни  

компьютер хотирасига сақлаш одатдагидек File менюсидаги Save қисмидан  

VSP форматида сақлаш мумкин. Ёки юқори панелдаги Share бўлимига 

кирилади.   

  

Тайёр файлни расмда кўрсатилганидек Create Video File қисмига кириб 

керакли форматда керакли жойга ёки дискка сақлаш мумкин.  

 Топшириқ: 

1. Ҳар бир талаба Ulead Videostudio 10 дастурида ўз исми ва 

фамилиясини ёзиб, VSP форматида компьютер хотирасига сақласин. 

Назорат саволлари. 

1. Ulead Videostudio 10 дастури қандай ишга туширилади. 

2. Ulead Videostudio 10 дастурида матнни қандай киритилади.  

3. Ulead Videostudio 10 дастурида ишланган ихтиёрий файлни қайси 

усулларда компьютер хотирасига киритиш мумкин. 
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7 - Лаборатория иши. 

 

 Мавзу:  Ulead Videostudio 10 дастурида овоз ва видеолар билан ишлаш 

  

Ишнинг мақсади: Ulead Videostudio 10 дастурида овоз ва видеолар билан 

ишлашни ўрганиш 

 

Назарий қисм:  

Ulead Videostudio 10 дастурида овоз видеолар билан ишлаш учун керакли 

файлни компьютер хотирасидан ёки ташқи қурилмалардан чақириб олиш 

мумкин.  

 

Бу рўйхатдан видео, расм ёки овозли файлларни чақириб олиш мумкин.  
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Овозли файл чақириб олингандан сўнг Audio Viev қисмига кирилса овозли файл 

овозини пасайтириш, юқорилатиш имконияти пайдо бўлади.  
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Топшириқ. 

Бирорта видеоклип ва бошқа овозли файл чақириб олиниб, видеоклип 

овози ўрнига овозли файл овози қўйилсин ва VCD форматида хотирага 

сақлансин.  

Назорат саволлари.  

1. Ulead Videostudio 10 дастурида видеофайллар компьютер 

хотирасидан қандай чақириб олинади. 

2. Ulead Videostudio 10 дастурида аудеофайллар компьютер 

хотирасидан қандай чақириб олинади. 

3. Аудеофайллар овози қандай бошқарилади. 

  

8 - Лаборатория иши. 
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    Мавзу:  Ulead Videostudio 10 дастурида видеоэффектлар билан ишлаш 

 

 Ишнинг мақсади: Ulead Videostudio 10 дастурида видеоэффектлар билан 

ишлашни ўрганиш 

Назарий қисм: Ulead Videostudio 10 дастурида видеофайлларни қайта ишлаш, 

безаш, бир неча бўлакларга ажратиш (кесиш) мумкин. Буни қуйидаги мисол 

ёрдамида кўриб чиқиш мумкин. Аввало бирор видеофайл чақириб оламиз ва 

уни бир неча бўлакларга ажратамиз.  

   

 

Юқори панелдаги Effect бўлимига кириб, у ердаги эффектлар ҳосил 

қилиш учун мўлжалланган андозаларни бўлакланган видеофайллар орасига 

жойлаштириш мумкин.   
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 Кадрларнинг алмашиш вақтини тезлаштириш ёки секинлаштириш 

мумкин. Бошқа овоз ёзиш ҳам мумкин. Яна турли эффектлар ҳам қўшиш 

мумкин. Ёки расмлар билан ҳам ҳудди шундай ишлаш мумкин.  

 

Топшириқ.  Камида 20 та расм ёки битта видеоклип устида эффеклар 

билан ишлансин. Тайёр маълумотни MPEG форматида компьютер хотирасига 

сақлансин.  

 Назорат саволлари:  

1. Видеофайл устига ёзув қандай ёзилади.  

2. Видеоэффеклар қандай ҳосил қилинади. 

3. Бир видеофайлни бир неча бўлакларга бўлиш қандай амалга 

оширилади. 
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